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Preface
Read this introduction for the documentation conventions used throughout, additional reading, and contact 
information. This preface includes the following sections:

 “About This Guide” on page 5 

 “Document Conventions” on page 6

 “Documentation and Release Notes” on page 6

 “Contacting Riverbed” on page 6

About This Guide

The guide describes how to install and configure the SteelCentral Controller for SteelHead (virtual edition) 
(Controller-v).

This guide includes information relevant to the following products:

 Riverbed SteelCentral Controller for SteelHead (SCC)

 SteelCentral Controller for SteelHead (virtual edition) (Controller-v)

 Riverbed SteelHead (SteelHead)

 Riverbed Optimization System (RiOS)

Audience

This guide is written for storage and network administrators with familiarity administering and managing 
WANs using common network protocols such as TCP, CIFS, HTTP, FTP, and NFS.
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Preface Document Conventions
Document Conventions

This manual uses the following standard set of typographical conventions to introduce new terms, illustrate 
screen displays, and describe command syntax.

Documentation and Release Notes

To obtain the most current version of all Riverbed documentation, go to the Riverbed Support site at 
https://support.riverbed.com. 

If you need more information, see the Riverbed Knowledge Base for any known issues, how-to documents, 
system requirements, and common error messages. You can browse titles or search for keywords and 
strings. To access the Riverbed Knowledge Base, log in to the Riverbed Support site at 
https://support.riverbed.com.

Each software release includes release notes. The release notes identify new features in the software as well 
as known and fixed problems. To obtain the most current version of the release notes, go to the Software 
and Documentation section of the Riverbed Support site at https://support.riverbed.com. 

Examine the release notes before you begin the installation and configuration process.

Contacting Riverbed

This section describes how to contact departments within Riverbed.

 Technical support - If you have problems installing, using, or replacing Riverbed products, contact 
Riverbed Support or your channel partner who provides support. To contact Riverbed Support, open a 
trouble ticket by calling 1-888-RVBD-TAC (1-888-782-3822) in the United States and Canada or +1 415-
247-7381 outside the United States. You can also go to https://support.riverbed.com.

Convention Meaning

italics Within text, new terms and emphasized words appear in italic typeface. 

boldface Within text, CLI commands, CLI parameters, and REST API properties appear in bold typeface.

Courier Code examples appear in Courier font:

amnesiac > enable
amnesiac # configure terminal

< > Values that you specify appear in angle brackets: interface <ip-address>

[ ] Optional keywords or variables appear in brackets: ntp peer <ip-address> [version <number>] 

{ } Elements that are part of a required choice appear in braces: {<interface-name> | ascii <string> | 
hex <string>}

| The pipe symbol separates alternative, mutually exclusive elements of a choice. The pipe symbol 
is used in conjunction with braces or brackets; the braces or brackets group the choices and 
identify them as required or optional: {delete <filename> | upload <filename>}
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Contacting Riverbed Preface
 Professional services - Riverbed has a staff of professionals who can help you with installation, 
provisioning, network redesign, project management, custom designs, consolidation project design, 
and custom coded solutions. To contact Riverbed Professional Services, email proserve@riverbed.com 
or go to http://www.riverbed.com/services-training/Services-Training.html. 

 Documentation - The Riverbed Technical Publications team continually strives to improve the quality 
and usability of Riverbed documentation. Riverbed appreciates any suggestions you might have about 
its online documentation or printed materials. Send documentation comments to 
techpubs@riverbed.com.
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CHAPTER 1 Overview of the Controller-v
This chapter provides an overview of the Controller-v: a virtualized appliance of the SteelCentral Controller 
for SteelHead specifically designed for customers (such as Managed Service Providers) and users who need 
to centrally manage multiple, separate deployments of the Riverbed system on behalf of their customers. 
This chapter includes the following sections:

 “Prerequisites” on page 9

 “Overview of the Controller-v” on page 10

 “VMware ESXi” on page 11

Prerequisites

This section describes the prerequisites necessary to install the product.

Product Licensing

All licensing must be properly in place. Appliances can still be managed if appliance licenses are valid and 
available. 

You need to have valid licenses installed on all appliances that you want to manage with the Controller-v.

A missing base license on an appliance can cause the health of the Controller-v to become critical and 
temporarily invalidates other Controller-v licenses which in turn prevents management of appliances.

Networking Requirements

You can access each Controller-v instance through HTTP, HTTPS, or SSH. You can configure the default 
access protocol in the Management Console. For details, see the SteelCentral Controller for SteelHead User’s 
Guide.

For SteelHead management, each Controller-v instance requires port 80 and port 443 inbound from the 
SteelHeads and port 22 outbound from each Controller-v instance to SteelHeads.
SteelCentral Controller for SteelHead (Virtual Edition) Installation Guide     9



            

Overview of the Controller-v Overview of the Controller-v
Hardware Requirements for VMware Infrastructure Client

The installation process requires accessing the VMware Infrastructure Client (VIC) on a Windows 
workstation. For requirements, see the VMware documentation.

Hardware Requirements per Controller-v Instance

The Controller-v consists of three files:

 Hard disk 1 contains the operating system. The default value is 22 GB. 

 Hard disk 2 is for statistics storage and must be provisioned according to the following table. The 
default value is 5 GB. The minimum allocation value is 8 GB.

 Hard disk 3 is for RSP image and package management and must be provisioned based on total size of 
the image and package files. The default value is 2 GB.

The total datastore space required for the Controller-v is the sum of the three VMDK files with a minimum 
value of 32 GB to a maximum of over 400 GB.

This table describes the minimum hardware requirements per Controller-v instance.

* Use the 64-bit Controller-v when managing more than 100 appliances. 

Third-Party Software Requirements

The following table describes the third-party software requirements for the Controller-v.

Overview of the Controller-v

The Controller-v facilitates the following administrative tasks as a multitenant solution for managing 
deployments of the Riverbed system across parallel network environments.

Number of Appliances Managed Hard disk 2 RAM CPU (effective)

Up to 10 8 GB 2 GB 1 core, 1 GHz

Up to 50 25 GB 2 GB 1 core, 1 GHz

Up to 100 100 GB 4 GB 2 cores, 2 GHz

Up to 250* 125 GB 4 GB 2 cores, 2 GHz

Up to 500* 400 GB 8 GB 2 cores, 2 GHz

Up to 2000* 400 GB 8 GB 4 cores, 4 GHz

Component Description

VMware VMware ESXi 5.5

SCC Management Console The SCC has been tested with Mozilla Firefox Extended Support 
Release version 38 and Microsoft Internet Explorer 11.

JavaScript and cookies must be enabled in your web browser.
10 SteelCentral Controller for SteelHead (Virtual Edition) Installation Guide



        

VMware ESXi Overview of the Controller-v
 Multiple Instances - The Controller-v is a virtual appliance that is installed in your VMware ESXi 
cluster. You can run multiple Controller-v instances, provided that the ESXi platform has sufficient 
hardware resources and the appropriate licenses are available.

 Configuration - The Controller-v enables you to automatically configure new SteelHead groups or to 
send configuration settings to appliances in remote offices. The Controller-v uses configuration objects 
(that is, policies and groups) to facilitate centralized configuration and reporting.

 Monitoring - The Controller-v provides both high-level status of and detailed statistics about the 
performance of SteelHeads and enables you to configure event notification for managed SteelHeads.

 Management - The Controller-v enables you to start, stop, restart, and reboot remote SteelHeads. You 
can also schedule jobs to send software upgrades and configuration changes to remote appliances or to 
collect logs from remote SteelHeads.

 Partial Federation - You can put any appliance into branch-managed mode to prevent configuration 
changes or maintenance operations from the Controller-v. The Controller-v continues to monitor and 
gather statistics from appliances that are branch managed.

 Operations History - The Operations History page in the Management Console lists all of the actions 
related to configuring SteelHeads that have been performed and indicates whether they were 
successful or not.

VMware ESXi

VMware ESXi is a virtualization platform that enables that enable you to install and run the SteelCentral 
Controller for SteelHead as a virtual appliance. For details about VMware ESXi, see http://
www.vmware.com.

For details about implementation requirements for the Controller-v, see “Prerequisites” on page 9.
SteelCentral Controller for SteelHead (Virtual Edition) Installation Guide       11
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CHAPTER 2 Managing Riverbed Licenses
This chapter describes the Riverbed licensing methods and how to manage Riverbed licenses. It includes 
these sections:

 “Riverbed Licensing Methods” on page 13

 “Retrieving Licenses Using the Riverbed Licensing Portal” on page 14

 “Installing Your License Keys” on page 14

Riverbed Licensing Methods

A license is a string issued by Riverbed that embeds information that ties the license to data to prevent 
tampering. After you install the license, the system saves it in the configuration database and enables the 
functionality associated with the license. Riverbed employs the following licensing methods:

 Manual Licensing - You can manually fetch and activate licenses for Riverbed products using the 
Riverbed Licensing Portal. Go to https://licensing.riverbed.com/index.htm and follow the 
instructions to retrieve and activate license keys. 

 Factory Licensing - You can have all your Riverbed licenses installed at the factory for a small fee.

 Token Method - You use tokens to activate Riverbed software, such as the Virtual SteelCentral 
Controller for SteelHead Mobile, Virtual SteelStore, SteelHead (virtual edition), and HP ProCurve. For 
detailed information, see the respective installation guides for these products.
SteelCentral Controller for SteelHead (Virtual Edition) Installation Guide     13
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Manual Licensing Using the Riverbed Licensing Portal

You can retrieve and manage Riverbed licenses using the Riverbed Licensing Portal. Once you retrieve a 
license from the Riverbed Licensing Portal, you need to install it. 

Retrieving Licenses Using the Riverbed Licensing Portal

The licensing portal requires a unique product identifier to retrieve a license. Depending on the product, 
the identifier can be a serial number, a license request key (activation code), or a token. The steps to retrieve 
a license vary based on the product identifier. Online instructions guide you through the process.

To retrieve your licenses for an appliance using a serial number

1. Go to the License page in the Riverbed Licensing Portal at https://licensing.riverbed.com/index.htm.

2. Enter your appliance serial number as your unique product identifier.

The serial number is on a label located on your appliance. It also appears in the Help tab of the SCC 
Management Console. 

3. Click Next.

4. Provide the contact information for the license, including your name and email.

5. Click Submit to display license information for all the products purchased with the serial number you 
specified. 

6. Click a serial number to see license details. 

7. Optionally, if you are behind a firewall, type the email address in the Email address text box and click 
Email Keys to have the license keys emailed to you.

8. Optionally, if you are behind a firewall, click Download XML to download an XML file. The XML file 
can be imported by the SteelCentral Controller for SteelHead.

Tip: Click New Search to look for additional license records.

Installing Your License Keys

Because each license key is generated for a specific appliance, ensure that you install your license key on 
the appropriate appliance.

To install a license using the SCC Management Console

1. Connect to the SCC Management Console of the appliance. For details, see the SteelCentral Controller for 
SteelHead User’s Guide.
14 SteelCentral Controller for SteelHead (Virtual Edition) Installation Guide
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Installing Your License Keys Managing Riverbed Licenses
2. Choose Administration > Maintenance: Licenses to display the Licenses page.

3. Click + Add New License to expand the page.

4. Copy and paste the license key provided by Riverbed Licensing Portal into the text box. Separate 
multiple license keys with a space, Tab, or Enter.

5. Click Add to display the license in the table.

You can also install a license key using the SCC command-line interface (CLI). 

To install a license using the CLI

1. Connect to the CLI of the appliance and enter configuration mode. 

For details see the Riverbed Command-Line Interface Reference Manual.

2. At the system prompt, enter the following commands:

license install <license-key>
write memory
SteelCentral Controller for SteelHead (Virtual Edition) Installation Guide       15
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CHAPTER 3 Installing the Controller-v
This chapter describes how to install and configure the SteelCentral Controller for SteelHead (virtual 
edition) (Controller-v). Controller-v requires Controller-v models 8001 (32-bit) or 8151 (64-bit).

This chapter includes the following sections:

 “Completing the Configuration Checklist” on page 17

 “Installing the Controller-v” on page 18

 “Completing the Initial Configuration” on page 19

 “Verifying Your Connections” on page 21

 “Logging In to the Controller-v Console” on page 21

Completing the Configuration Checklist

This section lists the parameters you specify to complete the initial configuration of the Controller-v and to 
register remote SteelHeads.

Be prepared to provide values for the parameters listed in the following checklist.

Appliance Parameter Your Value

SCC Hostname

IP address

Netmask

Default gateway

DNS Server

Domain Name
SteelCentral Controller for SteelHead (Virtual Edition) Installation Guide     17
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Installing the Controller-v 

This section describes the procedures for installing the virtual machine package obtained from Riverbed.

The Controller-v supports VMware ESXi. However, installation procedures vary depending on whether 
you are using VMware VI or vSphere Client. 

The Controller-v is provided by Riverbed as both an .ova file for ESXi and a zip file that contains the VMX 
and VMDK files that are necessary to create the virtual machine. 

Important: If you are using the vSphere Client, Riverbed recommends you install from the .ova file. 

Installing with the VMware vSphere Client

This section describes how to install the Controller-v from an OVA package using the VMware vSphere 
Client. 

To install with the VMware vSphere Client 

1. Obtain the OVA package from the Downloads section of the Riverbed Support website at https://
support.riverbed.com. (Access requires registration.)

2. Open the VMware vSphere Client.

3. In the left column, select an ESXi host.

4. Choose File > Deploy OVF Template.

5. Select one of the following methods:

– To install from a location served by a web server, select Deploy from URL and specify the URL to 
the .ova file.

Deploying directly from https://support.riverbed.com is not supported.

– To install from a location served by a file server, select Deploy from File and point to the .ova file.

6. Click Next.

7. Follow the prompts for the following configurations:

Remote SteelHeads Serial number

Version

IP address or hostname

User name

Password

Appliance Parameter Your Value
18 SteelCentral Controller for SteelHead (Virtual Edition) Installation Guide



        

Completing the Initial Configuration Installing the Controller-v
– Name and Location - Specify a suitable name for the Controller-v.

– Datastore - Select the preferred datastore from the list.

– Network Mapping - For both the Primary and Auxiliary interfaces, specify the destination 
networks.

8. Click Finish to complete the installation. For more information on hardware requirements, see 
“Prerequisites” on page 9.

9. Choose File> Virtual Appliance> Import to open the Import Virtual Appliance Wizard.

10. In the Import Location screen, specify the location of the virtual machine package (*.ovf), and click Next.

If you downloaded the image, use the Import from file option. If Riverbed has provided you with a 
URL, use the Import from URL option.

11. In the Virtual Appliance Details screen, review the information to confirm that the correct virtual 
machine package (*.ovf) is selected, and click Next.

12. In the Name and Location screen, specify the name for the virtual appliance and select the directory, and 
click Next.

13. In the Host/Cluster screen, select the host or cluster on which to run the virtual appliance, and click 
Next.

14. If you selected a cluster in the preceding step, specify the specific host within the cluster (as prompted 
in the subsequent Specific Host screen), and click Next.

15. In the Datastore screen, select the data store for storing the files for the virtual appliance, and click Next.

16. In the Network Mapping screen, map the networks used in the virtual appliance to networks used in 
the virtual infrastructure, and click Next.

17. In the Ready to Complete screen, review the summary of the settings specified in the preceding screens.

18. Click Finish.

The installation begins. The virtual machine package is approximately 2 GB in size; depending on local 
network conditions, the installation process might take up to forty five minutes or possibly longer.

Completing the Initial Configuration

This section describes how to complete the initial configuration of the Controller-v.

To configure the Controller-v

1. After you log in to the Controller-v as administrator, the system prompts you to start the configuration 
wizard. 

Enter yes at the system prompt:

Configuration wizard.
Do you want to use the wizard for initial configuration? yes
SteelCentral Controller for SteelHead (Virtual Edition) Installation Guide       19



            

Installing the Controller-v Completing the Initial Configuration
2. Complete the configuration wizard steps as described in the following table.

Tip: Press Enter to enter the default value. If you mistakenly answer no, you can start the configuration wizard by 
entering configuration jump-start at the system prompt.

Tip: Press ? for help. Press Ctrl-B to go back to the previous step.

3. Confirm your settings.

You have entered the following information:
1. Hostname: minna
2. Use DHCP: no
3. Primary IP address: 10.0.0.74

Wizard Prompt Description Example

Step 1: Host Name? Enter the hostname for the Controller-
v.

Step 1: Hostname? minna

Step 2: Use DHCP? You are given the option to enable the 
DHCP to automatically assign an IP 
address to the primary interface for 
the Controller-v. 

Riverbed recommends that you do not 
set DHCP. 

The default value is no. 

Step 2: Use DHCP? no

Step 3: Primary IP address? Enter the IP address for the 
Controller-v.

Step 3: Primary IP address? 
10.0.0.74

Step 4: Netmask? Enter the netmask for the network on 
which the Controller-v is to reside.

Step 4: Netmask? 255.255.0.0

Step 5: Default gateway? Enter the default gateway for the 
network on which the Controller-v is 
to reside.

Step 5: Default gateway? 
10.0.0.1

Step 6: Primary DNS server? Enter the primary DNS server for the 
network on which the Controller-v is 
to reside.

Step 6: Primary DNS server? 
10.0.0.2

Step 7: Domain name? Enter the domain name for the 
network on which the Controller-v is 
to reside.

If you set a domain name, you need 
not specify the domain names when 
you set up remote appliances to be 
managed by the Controller-v.

Note: When you configure DNS server 
settings, map riverbedcmc to the IP 
address for the Controller-v. 

Step 7: Domain name? example.com

Step 8: Admin password? Riverbed strongly recommends that 
you change the default password at 
this time. The password must contain 
at least 6 characters. 

The default administrator password is 
password. 

Step 8: Admin password? xxxyyy
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Verifying Your Connections Installing the Controller-v
4. Netmask: 255.255.0.0
5. Default gateway: 10.0.0.1
6. Primary DNS server: 10.0.0.2
7. Domain name: example.com
8. Admin password: xxxyyy

To change an answer, enter the step number to return to.
Otherwise hit <enter> to save changes and exit.
Choice:

The Controller-v configuration wizard automatically saves your initial configuration settings.

4. To log out of the system, enter the following command at the system prompt:

# exit

Verifying Your Connections

This section describes how to verify that you have properly connected the Controller-v. 

To verify your connections

1. From a remote host, connect to the Controller-v CLI. At the system prompt, enter one of the following 
commands:

ssh admin@<host>.<domain>

or

ssh admin@<ipaddress>

2. When you are prompted for a password, specify the administrator password you set when you ran the 
configuration wizard. 

3. At the system prompt, enter ping commands to verify the connections:

ping -I <primary-IP-address> <primary-default-gateway>

Logging In to the Controller-v Console

After you install the Controller-v, you can check and modify your configuration settings and view 
performance reports and system logs in the SCC console. You can connect to the console through any 
supported web browser.

To connect to the console, you must know the host, domain, and administrator password that you assigned 
in the configuration wizard. 

Important: Cookies and JavaScript must be enabled in your web browser.

Important: Before you begin, clear your browser cache and cookies to ensure the user interface displays correctly.
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Installing the Controller-v Logging In to the Controller-v Console
To connect to the SCC console

1. Enter the URL for the SCC in the location box of your browser:

<protocol>://<host>.<domain>

<protocol> is http or https. The secure HTTPS uses the SSL protocol to ensure a secure environment. 
When you connect using HTTPS, you are prompted to inspect and verify the SSL certificate. This is a 
self-signed certificate used to provide encrypted web connections to the SCC. 

<host> is the IP address or hostname you assigned the SCC during initial configuration. If your DNS 
server maps the IP address to a name, you can specify the DNS name.

<domain> is the full domain name for the SCC.

The SCC Login page displays.

2. In the text box, specify the user login: admin, monitor, a login from a RADIUS or a TACACS+ database, 
or a previously configured RBM account. 

The default login is admin. Users with administrator privileges can configure and administer the SCC. 
Users with monitor privileges can view SCC reports but they cannot configure the system.

3. In the Password text box, specify the password you assigned in the configuration wizard of the SCC. 

The SCC is shipped with password as the default password.

4. Click Sign In to log in to display the Dashboard.
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